












CBERS - 2 

CBERS - 2B 

CBERS - 4 

Inativo Ativo 

CBERS - 04A está previsto lançamento para 

o segundo semestre de 2019 pelo Centro de 

Lançamento de Satélites de Tayuan - China. 





Conforme algumas de suas câmeras: 

CCD, PAN e MUX:  Trabalhos relacionados à Vegetação; Agricultura; 

Meio ambiente; Água; Cartografia; Geologia; Solos; e apoio na 

Educação. 

IRMSS tem as mesmas aplicações da CCD, mas com adaptações 

para: Análise de fenômenos que apresentem alterações de 

temperatura da superfície; Geração de mosaicos estaduais; e 

Geração de cartas-imagens. 

WFI: Geração de mosaicos nacionais ou estaduais; Geração de 

índices de vegetação para fins de monitoramento; Monitoramento de 

fenômenos dinâmicos, como safras agrícolas, queimadas 

persistentes; e Sistema de alerta. 

PAN (Câmera Pancromática e Multiespectral): Geração de mosaicos 

nacionais ou estaduais detalhados; Atualização de cartas temáticas e 

outros tipos de cartas; Imageamento de áreas de desastres e 

emergenciais; e Aplicações urbanas e de inteligência. 

http://www.cbers.inpe.br/sobre/usos_aplicacoes.php 



http://www3.inpe.br/snct2015/arquivos/Clima_Espacial_Satelites_Aplicacoes_OBT.pdf 



LANDSAT 

LANDSAT-1 

LANDSAT-2 

LANDSAT-3 

LANDSAT-5 

LANDSAT-7 

LANDSAT-8 

Inativo Ativo Ativo com restrições 

http://www.dgi.inpe.br/documentacao/satelites/landsat 





De acordo com suas câmeras: 

No uso e cobertura do solo (Vegetação; Solos 

expostos; Estradas; Áreas urbanas; Parcelamento do 

solo; Variação litológica; Mapeamento da drenagem; 

mapeamento de feições geológicas e estruturais. 

Serve para mapear áreas ocupadas com pinus e 

eucalipto; Vegetação que sofreu queimadas; 

Visualização de áreas com macrófitas aquáticas; 

Identificação de áreas agrícolas, e etc.). 

http://www.dgi.inpe.br/Suporte/files/Cameras-LANDSAT57_PT.php 



http://www3.inpe.br/snct2015/arquivos/Clima_Espacial_Satelites_Aplicacoes_OBT.pdf 









 
 
    Classificação de Nuvens 
    Descargas Elétricas 
    Índice Ultravioleta 
    Monitoramento de Secas 
    Nevoeiros 
    Oceanografia por Satélite 
    Precipitação por Radar 
    Precipitação por Satélite 
    Queimadas 
    Radiação Solar e Terrestre 
    Sistemas Convectivos 
    Vento na Troposfera 
 
 

http://satelite.cptec.inpe.br/home/index.jsp
http://satelite.cptec.inpe.br/home/index.jsp
http://satelite.cptec.inpe.br/home/index.jsp
http://satelite.cptec.inpe.br/home/index.jsp


http://satelite.cptec.inpe.br/pedidoweb/pedido.formulario.logic
http://satelite.cptec.inpe.br/pedidoweb/pedido.formulario.logic
http://satelite.cptec.inpe.br/pedidoweb/pedido.formulario.logic
http://satelite.cptec.inpe.br/pedidoweb/pedido.formulario.logic


http://satelite.cptec.inpe.br/pedidoweb/pedido.formulario.logic
http://satelite.cptec.inpe.br/pedidoweb/pedido.formulario.logic
http://satelite.cptec.inpe.br/pedidoweb/pedido.formulario.logic
http://satelite.cptec.inpe.br/pedidoweb/pedido.formulario.logic


http://sigma.cptec.inpe.br/nuvens/  

http://sigma.cptec.inpe.br/nuvens/
http://sigma.cptec.inpe.br/nuvens/


http://sigma2.cptec.inpe.br/raio/  

http://sigma2.cptec.inpe.br/raio/
http://sigma2.cptec.inpe.br/raio/
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A energia emitida pela superfície terrestre pode 
ser convertida em temperatura através de 
modelos físicos.  

O sensor acoplado ao satélite permite registrar 
temperaturas que estejam acima de certo limiar 
(definido por especialistas em combustão) e 
relacionar as presenças dessas regiões como 
áreas em que ocorrem focos de calor. 

Fonte: NOVO (2008). 
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Para que um foco de calor seja interpretado como um 
possível foco de fogo, a informação extraída do 
satélite precisa ser associada a outras informações em 
um SIG, como: 

Condições de precipitação; 
Temperatura; 
Umidade; 
Suscetibilidade da cobertura vegetal à combustão natural 
ou induzida; 
Distribuição de usos da terra, práticas agrícolas, culturas 
dominantes, etc. 

Fonte: NOVO (2008). 
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Quanto maior o nº de “camadas” de informações 
agregadas à distribuição de focos de calor, mais precisa 
será a previsão sobre a ocorrência de focos de fogo, e 
mais eficiente torna-se a ação dos órgãos de 
fiscalização. 

Fonte: NOVO (2008). 
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O portal do Projeto Queimadas desenvolvido pelo  INPE, 
tem como tema a ocorrência de fogo na vegetação. Ele 
inclui o monitoramento operacional de focos de 
queimadas e de incêndios florestais detectados por 
satélites, e o cálculo e previsão do risco de fogo da 
vegetação. 

Os dados para a América do Sul e Central, África e Europa, 
são atualizados a cada 3 hs todos os dias do ano. O acesso 
às informações é livre e permite visualizar e baixar figuras, 
tabelas e gráficos. 

Fonte: http://queimadas.dgi.inpe.br/queimadas/portal/informacoes/apresentacao 



28 

Fonte: http://queimadas.dgi.inpe.br/queimadas/portal 



29 Fonte: http://queimadas.dgi.inpe.br/queimadas/bdqueimadas 



Baixando os dados geográficos 

Fonte: http://queimadas.dgi.inpe.br/queimadas/bdqueimadas 



Baixando os dados geográficos 

Fonte: http://queimadas.dgi.inpe.br/queimadas/bdqueimadas 



Como analisar os dados 
geográficos gerados? 

32 
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Os mapas de densidade Kernel constituem-se 
uma poderosa ferramenta para análise espacial... 

... que pode ser definida como uma técnica que 
busca descrever os padrões existentes nos dados 
espaciais e estabelecer, preferencialmente de 
forma quantitativa, a relação entre as diferentes 
variáveis geográficas. 

Fonte: SILVA et al. (2015). 
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A estimativa Kernel é uma técnica de interpolação que gera uma 
superfície de densidade para a identificação visual de “áreas 
quentes”. Entende-se a ocorrência de uma área quente como uma 
concentração de eventos que indica de alguma forma a 
aglomeração em uma distribuição espacial (BRASIL, 2007). 

Fonte: SOUZA et al. (2013). Fonte: FORGIARINI et al. (2018). 
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É uma boa alternativa para se avaliar o comportamento 
dos padrões de pontos em uma determinada área de 
estudo, sendo considerado muito útil para fornecer uma 
visão geral da distribuição de primeira ordem dos eventos 
(CARVALHO e CÂMARA, 2002). 

Aplicando densidade Kernel Pontos sem tratamento 

Fonte: INPE (2019). Dados ogranizados e compilados pelos próprios autores. 
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No software ArcGIS® a estimativa de densidade em um novo 
local (x, y) é dada por: 

Onde: 
f(x, y) = valor da densidade no ponto (x, y); 
n = número de observações; 
h = raio de pesquisa; e 
di = distância entre a observação i e o ponto (x, y). 

𝒇 𝒙, 𝒚 =  
𝟏

𝒉𝟐
 
𝟑

𝝅
∗ 𝒏 𝟏 − 

𝒅𝒊

𝒉

𝟐 𝟐𝒏

𝒊=𝟏

 

Fonte: https://pro.arcgis.com/en/pro-app/tool-reference/spatial-analyst/how-kernel-density-works.htm 
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Essa função realiza uma contagem de todos os pontos dentro de 
uma região de influência (raio de pesquisa), ponderando-os pela 
distância de cada um em relação à localização de interesse (di). 

O valor para a célula é a soma dos valores kernel sobrepostos, e 
divididos pela área de cada raio de pesquisa. 

Dessa forma, pode-se ajustar uma função bidimensional sobre os 
eventos considerados, compondo uma superfície cujo valor será 
proporcional à intensidade de amostras (pontos) por unidade de 
área.  

Fonte: SOUZA et al. (2013); SILVA et al. (2015). 
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Fonte: SOUZA et al. (2013); SILVA et al. (2015). 

O raio de pesquisa (h) é o raio de um disco, centrado em S, que é 
uma localização na região R, no qual pontos Si vão contribuir para 
a estimativa da função de densidade. 
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O raio de pesquisa cria a suavização da superfície, isto é, 
o valor da superfície será maior quanto mais próximo 
um ponto for do outro, sendo o oposto verdadeiro, e 
nula quando a distância entre os pontos for igual a do 
raio de pesquisa.   

A escolha do padrão de suavização é de importância 
fundamental na estimativa da densidade dos eventos e 
depende do objetivo do estudo e do tipo de evento 
estudado. 

Fonte: BRASIL (2007);  
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Como escolher o raio de pesquisa? 
• Para identificar áreas específicas e de menor abrangência para 

atuação, valores menores de raio de pesquisa podem ser mais 
indicados (ex: doenças transmitidas por insetos). 

• Se o objetivo é identificar áreas mais abrangentes para 
otimizar intervenções, a largura da banda mais ampla torna-se 
a melhor opção.  

No geral, dependendo do padrão a ser analisado: 
• Transições graduais         raios maiores  
• Pequenos agrupamentos         raios menores  

Fonte: BRASIL (2007). 
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Fonte: FORGIARINI et al. (2018). 

Mapas de densidade kernel de doenças diarreicas agudas, segundo os diferentes raios de 
pesquisa 



Fonte: Adaptado de CÂMARA et al. (2002). 



Exemplo Prático 

utilizando o ArcGIS® 

A proposta da atividade é analisar a distribuição espacial dos focos de 

queimadas no Estado do Mato Grosso, através da criação de mapas de 

densidade Kernel. Para isso, serão utilizados dados de monitoramento do 

Banco de Dados de Queimadas do Instituto Nacional de Pesquisas 

Espaciais -INPE, para o período de 13/10/2018 a 13/10/2019. A fim de 

exemplificar como esses focos se relacionam com as atividades humanas, 

foi escolhida, ainda, uma área de estudo para compor tal análise.  
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Etapa 1: Abrir os dados geográficos 



Etapa 2: Aplicar a densidade Kernel  

ArcToolBox → Spatial Analyst Tools → Density → Kernel Density 



Janela Kernel Density 
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O tamanho da célula de saída (output cell size) 
está relacionado com o tamanho do pixel do 
arquivo raster de saída que será criado. 

A unidade de área pode ser: quilômetros 
quadrados, metros quadrados, acres, hectares, 
entre outros. 

Fonte: http://desktop.arcgis.com/en/arcmap/10.3/tools/spatial-analyst-toolbox/kernel-density.htm 
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O raio de pesquisa padrão do ArcGIS® é calculado pelo 
seguinte logaritmo:   

Onde: 
Dm = distância média do centro médio; 
n = número de pontos; 
SD = distância padrão. 
 

OBS: Note que a parte mínima da equação significa que a 
opção usada será a que resultar no menor valor. 

h = 𝟎, 𝟗 ∗ 𝒎𝒊𝒏 𝑺𝑫,
𝟏

𝒍𝒏(𝟐)
  ∗ 𝑫𝒎 ∗ 𝒏

−𝟎,𝟐     

Fonte: https://pro.arcgis.com/en/pro-app/tool-reference/spatial-analyst/how-kernel-density-works.htm 
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É altamente recomendável usar o método geodésico se 
os dados possuírem sistema de coordenadas que não é 
apropriado para medições de distância (por exemplo, 
qualquer sistema de coordenadas geográficas) e 
qualquer análise que abranja uma grande área 
geográfica, como a área de estudo da atividade. 

E ainda é possível escolher o método para o cálculo das 
distâncias entre as feições, utilizando-se de distâncias 
planares ou geodésicas. 

Fonte: http://desktop.arcgis.com/en/arcmap/10.3/tools/spatial-analyst-toolbox/kernel-density.htm 
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ArcToolBox → Data Management Tools → Raster → Raster Processing → Clip 
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OBS: os dados serão reclassificados para a simbologia Streched, logo teremos que ir em 
Properties → Symbology → Classified e reclassificar os dados (9 classes). 
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Selecionar a feição (município ou área especial) → botão direito no arquivo → 
Data → Export Data 
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Desmatamento 



No satélite há sensores que capturam a energia eletromagnética, popularmente conhecida 
como a luz. O sol emite essa luz que incide na superfície do planeta. Pode atingir água, 
prédios, árvores ou o solo descoberto. Cada obstáculo gera uma onda diferente que viaja de 
volta até o satélite, é processada e enviada aos radares na Terra. 

No INPE as imagens são analisadas por um programa de computador criado a partir da 
experiência dos técnicos. A cor, a forma, a textura e a atividade econômica da região 
estudada criam um padrão que revela se houve uma queimada, corte das árvores de maior 
valor na floresta ou derrubada indiscriminada da vegetação. 

Identificação de áreas desmatadas  

Fonte: JORNAL DA GLOBO, 2012. 



Fonte: http://terrabrasilis.dpi.inpe.br/ 

O TerraBrasilis é uma plataforma desenvolvida pelo Instituto Nacional de Pesquisas Espaciais 
(INPE) para organização, acesso e uso através de um portal web dos dados geográficos 
produzidos pelos seus programas de monitoramento ambiental. 

TerraBrasilis 



O projeto PRODES realiza o monitoramento por satélites do desmatamento por 
corte raso e produz as taxas anuais de desmatamento na região, que são usadas 
pelo governo brasileiro para o estabelecimento de políticas públicas. As taxas 
anuais são estimadas a partir dos incrementos de desmatamento identificados 
em cada imagem de satélite que cobre a região.  

As estimativas do PRODES são consideradas confiáveis pelos cientistas nacionais e 
internacionais. Esse sistema tem demonstrado ser de grande importância para 
ações e planejamento de políticas públicas da Amazônia. Resultados recentes, a 
partir de análises realizadas com especialistas independentes, indicam nível de 
precisão próximo a 95%. 

Fonte: http://www.obt.inpe.br/OBT/assuntos/programas/amazonia/prodes 

PRODES 



O DETER é o programa de detecção em tempo real que realiza um levantamento 
rápido de alertas de evidências de alteração da cobertura florestal, feito pelo 
INPE. O DETER foi desenvolvido como um sistema de alerta para dar suporte à 
fiscalização e controle de desmatamento e da degradação florestal realizadas pelo 
Instituto Brasileiro do Meio Ambiente e dos Recursos Naturais Renováveis 
(IBAMA) e demais órgãos ligados a esta temática. 

Fonte: http://www.obt.inpe.br/OBT/assuntos/programas/amazonia/deter  

Os resultados das detecções, por classe, estado, município e unidades de 
conservação federais estão disponíveis via consulta espacial no portal 
TerraBrasilis, onde é possível fazer o download em formato shapefile (*.shp) e os 
resultados das estatísticas por período de tempo estabelecido pelo usuário.  

DETER 



Quando surge uma clareira recente na área é emitido um alerta aos órgão de 
fiscalização. Alertas são emitidos diariamente para os estados da Amazônia Legal 
e são tantos que entram em uma fila de fiscalização. 

As coordenadas apontadas pelo satélite são um endereço certeiro no meio da 
floresta. Quando o acesso é difícil, a equipe vai de helicóptero. Em questão de 
minutos os fiscais encontram a clareira. 

A informação do Deter é transformada em plano de ação. A Amazônia é um 
ecossistema imenso e difícil de ser protegido. 

DETER 

O banco de dados do INPE orienta políticas do Ministério do Meio Ambiente. 

Fonte: JORNAL DA GLOBO, 2012. 



Fonte: http://terrabrasilis.dpi.inpe.br/ 

TerraBrasilis 



Fonte: http://terrabrasilis.dpi.inpe.br/app/map/deforestation?hl=pt-br 

Mapa de desmatamento 



Fonte: http://terrabrasilis.dpi.inpe.br/app/dashboard/deforestation/biomes/amazon/increments 

Dashboard de desmatamento  



Análises do desmatamento 

Ocupação demográfica da Amazônia legal nos últimos cinquenta anos tem levado 
a níveis significativos de desmatamento, resultante de múltiplos fatores, tais como 
a abertura de estradas pioneiras, o crescimento das cidades, a ampliação de 
pecuária extensiva, a acelerada exploração madeireira e a crescente agricultura 
intensiva de monoculturas (FERREIRA et al., 2005). 

Embora a floresta amazônica seja desmatada por inúmeras razões, a criação de 
gado ainda é a causa predominante. As fazendas de médio e grande porte são 
responsáveis por cerca de 70% das atividades de desmatamento (FEARNSIDE, 
2005). 



Área total desmatada na 

Amazônia Legal 

Fonte: FERREIRA et al. (2005). 

Análises do desmatamento 

Fonte: Autores (2019). 



Downloads na plataforma TerraBrasilis 



Fonte: http://terrabrasilis.dpi.inpe.br/ 

Baixando dados geográficos 



Fonte: http://terrabrasilis.dpi.inpe.br/downloads/ 

Baixando dados geográficos 



Utilizando o ArcGIS®: 
 

Confeccionar mapa das áreas de 
desmatamento ocorrido de 1988 a 

2018 no município de Medicilândia-PA.  



Etapa 1: Abrir os dados geográficos 



Etapa 2: Isolar a área de interesse  

Geoprocessing → Clip  



Desmatamento no município de Medicilândia-PA 



Análise da influência do desmatamento na  
temperatura de superfície  



O satélite Landsat-8 é o mais recente de sua série. Foi lançado no dia 11 de 
fevereiro de 2013 pela NASA na base aérea de Vandenberg no estado da 
Califórnia (EUA), operando a uma altitude de 705 km. A sua passagem na linha 
do equador ocorre às 10:00 horas, com diferença de 15 minutos para mais ou 
para menos (USGS, 2013).  

Satélite Landsat-8 

A cobertura das imagens desse satélite é de praticamente todo o globo, com 
exceção para as mais altas latitudes polares, ocorrendo a revisita a cada 16 dias. 
Ou seja, uma resolução temporal de 16 dias. O tamanho aproximado da cena é 
de 170 km ao norte-sul por 183 km a leste-oeste (COELHO e CORREA, 2013). 



A plataforma Landsat-8 opera com dois instrumentos imageadores, sendo o primeiro, Operational 
Land Imager (OLI), com nove bandas espectrais: 

Banda 1 - Visível Ultra-Azul (0.43 - 0.45 µm) 30 m - ideal para estudos costeiros e aerossol.  

Banda 2 - Visível Azul (0.450 - 0.51 µm) 30 m  

Banda 3 - Visível Verde (0.53 - 0.59 µm) 30 m  

Banda 4 - Visível Vermelho (0.64 - 0.67 µm) 30 m  

Banda 5 - Infravermelho Próximo (0.85 - 0.88 µm) 30 m  

Banda 6 - Infravermelho Médio/SWIR 1(1.57 - 1.65 µm) 30 m  

Banda 7 - Infravermelho Médio/SWIR 2 (2.11 - 2.29 µm) 30 m  

Banda 8 - Pancromática (PAN) (0.50 - 0.68 µm) 15 m  

Banda 9 - Cirrus (1.36 - 1.38 µm) 30 m – útil para detecção de nuvens  

Satélite Landsat-8 

Fonte: COELHO e CORREA (2013). 



O outro sistema imageador é o Thermal Infrared Sensor (TIRS) com duas bandas de pixel de 100 
metros, processadas e disponibilizadas em 30 metros, para coincidir com a maioria das bandas 
multiespectrais do sistema imageador OLI.  

Banda 10 - Infravermelho Termal/TIRS 1 (10.6 - 11.19 µm) 100 m - tratada e disponibilizada com pixel 
de 30 metros.  
 
Banda 11 - Infravermelho Termal/TIRS 2 (11.5 - 12.51 µm) 100 m - tratada e disponibilizada com pixel 
de 30 metros.  

Satélite Landsat-8 

O formato dos dados disponibilizados - de forma gratuita, baixado via internet - é um TXT 
(metadados) e GeoTIFFs em arquivo compactado com cerca de 1 GB (comprimido) a cerca de 2 GB 
(descompactado). A resolução radiométrica é de 16 Bits. 

Fonte: COELHO e CORREA (2013). 



Conversão de níveis de cinza da imagem (NC) para radiância: 

Tratamento da imagem infravermelha termal  

Depois converter a radiância para temperatura Kelvin disponibilizadas no Serviço 
Geológico Americano:  

Lλ = ML * Qcal + AL 

ln ( k1  +  1)  

        k2  

Lλ  

T =  

Lλ: Radiância Espectral do sensor 
ML: Fator multiplicativo de redimensionamento da 
banda 
Al: Fator de redimensionamento aditivo específico 
da banda 
Qcal: Valor quantizado calibrado pelo pixel em DN 
= Imagem banda 

T: Temperatura efetiva no satélite em Kelvin 
K2 : Constante de calibração 2 
K1 : Constante de calibração 1 
Lλ: Radiância Espectral do sensor 

(1) 

(2) 

Fonte: COELHO e CORREA (2013). 



Satélite Landsat-8 Banda 10  

Fonte: COELHO e CORREA (2013). 



Após este procedimento, os valores de temperatura Kelvin foram subtraídos 
pelo seu valor absoluto (273,15), gerando o raster de temperatura de superfície 
em graus Celsius (°C). 

Satélite Landsat-8 Banda 10  

Fórmula completa da inserção conjunta das equações (1), (2) e a subtração de 
273,15 para obtenção da temperatura Celsius: 
  

 TC= (1321.08/Ln(774.89/(3.3420E-04* “banda10.tif” + 0.10000)+1))-273.15 

Fonte: COELHO e CORREA (2013). 
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Utilizando o ArcGIS®: 
 

Realizar mapa temático da temperatura 
de superfície no município de 

Medicilândia-PA.  



Etapa 1: Abrir as imagens e dados geográficos: 



ArcToolBox → Data Management Tools → Raster → Raster Dataset→ Mosaic to New Raster 

Etapa 2: Unir as imagens de satélite: 



...gerando: 



Etapa 3: Recortar o raster gerado para obter o raster do município:  

ArcToolBox → Data Management Tools → Raster → Raster Processing → Clip 



...obtendo: 



Etapa 4: Gerar temperatura de superfície:  

ArcToolBox → Spatial Analyst Tools → Map Algebra → Raster Calculator 



OBS: As cores dos dados podem ser alterados em:  
Properties → Symbology → Stretched e reclassificar os dados na Color Ramp. 

... gerando: 



... depois de inserir o mapa de desmatamento e os componentes 
essenciais: 
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